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1.1 GETTING STARTED

The Wastewater module was developed using Microsoft® Excel 2000. While the module will
operate with older versions of Excel, it functions best with Excel 2000 or later. If you are
using Excel 2007 or later, instructions for opening the module will vary as outlined in the
Excel basics below. Before you use the Wastewater module, make sure your computer
meets the system requirements. In order to install and run the Wastewater module, you
must have:

e IBM-PC compatible computer with the Windows 95 operating system or later;

e Microsoft® Excel 1997 or later, with calculation set to automatic and macros
enabled;

e Hard drive with at least 20MB free; and

e Monitor display setting of 800 x 600 or greater.
Microsoft Excel Settings

Excel 2003 and Earlier: For the SIT modules to function properly, Excel must be set to
automatic calculation. To check this setting, launch Microsoft Excel before opening the
Wastewater module. Go to the Tools menu and select “Options...” Click on the
“Calculations” tab and make sure that the radio button next to "Automatic” is selected, and
then click on "OK” to close the window. The security settings (discussed next) can also be
adjusted at this time.

Excel 2007 and Later: For the SIT modules to function properly, Excel must be set to
automatic calculation. Go to the Formulas ribbon and select “Calculation Options.” Make
sure that the box next to the “"Automatic” option is checked from the pop-up menu.

Microsoft Excel Security

Excel 2003 and Earlier: Because the SIT employs macros, you must have Excel security
set to medium (recommended) or low (not recommended). To change this setting, launch
Microsoft Excel before opening the Wastewater module. Once in Excel, go to the Tools
menu, click on the Macro sub-menu, and then select “Security” (see Figure 1). The Security
pop-up box will appear. Click on the “Security Level” tab and select medium. When set to
high, macros are automatically disabled; when set to medium, Excel will give you the choice
to enable macros; when set to low, macros are always enabled.

When Excel security is set to medium, users are asked upon opening the module whether to
enable macros. Macros must be enabled in order for the Wastewater module to work. Once
they are enabled, the module will open to the control worksheet. A message box will
appear welcoming the user to the module. Clicking on the “x” in the upper-right-hand
corner of the message box will close it.

Excel 2007 and Later: If Excel’s security settings are set at the default level a Security
Warning appears above the formula box in Excel when the Wastewater module is initially
opened. The Security Warning lets the user know that some active content from the
spreadsheet has been disabled, meaning that Excel has prevented the macros in the
spreadsheet from functioning. Because SIT needs macros in order to function properly, the
user must click the “"Options” button in the security message and then select, “Enable this
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content” in the pop-up box. Enabling the macro content for the SIT in this way only enables
macros temporarily in Excel but does not change the macro security settings. Once macros
are enabled, a message box will appear welcoming the user to module. Click on the “"x” in
the upper right-hand corner to close the message box.

If the Security Warning does not appear when the module is first opened, it may be
necessary to change the security settings for macros. To change the setting, first exit out
of the Wastewater module and re-launch Microsoft Excel before opening the Wastewater
module. Next, click on the Microsoft Excel icon in the top left of the screen. Scroll to the
bottom of the menu and select the “Excel Options” button to the right of the main menu.
When the Excel Options box appears, select “"Trust Center” in left hand menu of the box.
Next, click the gray “Trust Center Settings” button. When the Trust Center options box
appears, click "Macro Settings” in the left-hand menu and select “Disable all macros with
notification.” Once the security level has been adjusted, open the Stationary Combustion
module and enable macros in the manner described in the preceding paragraph.

Viewing and Printing Data and Results

The Wastewater module contains some features to allow users to adjust the screen view
and the appearance of the worksheets when they are printed. Once a module has been
opened, you can adjust the zoom by going to the Module Options Menu, and either typing in
a zoom percentage or selecting one from the drop-down menu. In addition, data may not
all appear on a single screen within each worksheet; if not, you may need to scroll up or
down to view additional information.

You may also adjust the print margins of the worksheets to ensure that desired portions of
the Wastewater module are printed. To do so, go to the File menu, and then select “Print
Preview.” Click on “Page Break Preview” and drag the blue lines to the desired positions
(see Figure 2). To print this view, go to the File menu, and click “Print.” To return to the
normal view, go to the File menu, click “*Print Preview,” and then click "Normal View.”
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Figure 1. Changing Security Settings
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1.2 MODULE OVERVIEW

This User’s Guide accompanies and explains the Wastewater module of the SIT. The SIT
was developed in conjunction with EPA’s Emissions Inventory Improvement Program (EIIP).
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Prior to the development of the SIT, EPA developed the States Workbook for estimating
greenhouse gas emissions. In 1998, EPA revisited the States Workbook and expanded it to
follow the format of EIIP guidance documents for criteria air pollutants. The result was a
comprehensive, stepwise approach to estimating greenhouse gas emissions at the state
level. This detailed methodology was appreciated by states with the capacity to devote
considerable time and resources to the development of emission inventories. For other
states, the EIIP guidance was overwhelming and impractical for them to follow from scratch.
EPA recognized the resource constraints facing the states and developed the SIT. The ten
modules of the SIT corresponded to the EIIP chapters and attempted to automate the steps
states would need to take in developing their own emission estimates in a manner that was
consistent with prevailing national and state guidelines.

Because most state inventories developed today rely heavily on the tools, User’s Guides
have been developed for each of the SIT modules. These User’s Guides contain the most
up-to-date methodologies that are, for the most part, consistent with the Inventory of U.S.
Greenhouse Gas Emissions and Sinks. Volume VIII of the EIIP guidance is a historical
document that was last updated in August 2004, and while these documents can be a
valuable reference, they contain outdated emissions factors and, in some cases, outdated
methodologies. States can refer to Volume VIII of the EIIP guidance documents if they are
interested in obtaining additional information not found in the SIT or the companion User's
Guide.

The Wastewater module calculates
methane (CH4) and nitrous oxide
(N20) emissions from the treatment of In-state sources, such as state departments of
municipal and industrial wastewater. environmental protection, should be consulted first.
The module provides default data for Otherwise, default data provided by the Wastewater

. module may be used.
most inputs, however other more
state-specific data may be used if available (see Box 1 for suggestions on where to find
data). If using outside data sources, or for a more thorough understanding of the tool,
please refer to the Methodology section below for data requirements and methodology.

Box 1: Wastewater Data Sources

Disposal and treatment of industrial and municipal wastewater often result in CH4 emissions.
Wastewater may be treated using aerobic and/or anaerobic technologies, or if untreated,
may degrade under either aerobic or anaerobic conditions. CH4 is produced when organic
material is treated in anaerobic environment and when untreated wastewater degrades
anaerobically, i.e., in the absence of oxygen.

N20 is emitted from both domestic and industrial wastewater containing nitrogen-rich
organic matter. N20 is produced through the natural processes of nitrification and
denitrification. Nitrification occurs aerobically and converts ammonia into nitrate, whereas
denitrification occurs anaerobically, and converts nitrate to N2O. Human sewage is believed
to constitute a significant portion of the material responsible for N2O emissions from
wastewater (Spector 1997).
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1.2.1 Data Requirements

To calculate greenhouse gas emissions from wastewater, the data listed in Table 1 are
required inputs (again, note that defaults are available for most of these data).

Table 1. Required Data Inputs for the Wastewater Module

Wastewater Sectors Input Data
Municipal Wastewater: CHa Per capita 5-day biochemical oxygen demand (BODs) (kg/day)
Emissions

Fraction of wastewater BODs anaerobically digested
Emission factor (Gg CH4/Gg BOD:s)

State population

Municipal Wastewater: Direct Factor for non-consumption nitrogen

N,O Emission . . .
20 sslons Fraction of population not on septic

Direct wastewater treatment plant emissions (g N>O/person/year)

Municipal Wastewater: N,O Emission factor (kg N2O-N/kg sewage N produced)
Emissions from Biosolids . . . .
Fraction of nitrogen in protein (Fracner)
Protein content (kg/person/year)

Biosolids used as fertilizer (percentage)

Industrial Wastewater: Fruits Wastewater Outflow (m3/metric ton)

and Vegetables WW organic content - chemical oxygen demand (COD) (g/L)

Industrial Wastewater: Red Meat | Fraction of COD anaerobically degraded

Emission factor (g CHs/g COD)

Industrial Wastewater: Poultry Production processed (metric tons)

Industrial Wastewater: Pulp and | Wastewater Outflow (m3/metric ton)
Paper WW organic content - chemical oxygen demand (COD) (g/L)
Fraction of COD anaerobically degraded

Emission factor (g CH4/g COD)

Production processed of woodpulp and paper & paperboard
(metric tons)

1.2.2 Tool Layout
Because the methodology for estimating emissions from Wastewater treatment is complex,

it is important to understand the module’s overall design. The layout of the Wastewater
module and the purpose of its worksheets are presented in Figure 3.

State Greenhouse Gas Inventory Tool User’s Guide for the Wastewater Module 1.5



Module 10 - Wastewater Module January 2022

Figure 3. Flow of Information in the Wastewater Module

Control Worksheet Individual Sector Worksheets
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2. Select a State | Enter state population
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CH, Emissions 6. Municipal Wastewater N,O Emissions
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MN.C Emissions from Biosolids 7. Industrial Wastewater CH, - Fruits and Vegetables
Industrial VWastewater | Enter the amount of fruits and vegetables produced
Fruits and Vegetables 8. Industrial Wastewater CH, - Red Meat
Fed Meat } Enter the armount of red meat produced
Foultry 9. Industrial Wastewater CH, - Poultry
Pulp and Paper | Enter the armount of poultry produced
4. -10. Complete Sector Worksheets 10. Industrial Wastewater CH, - Pulp and Paper
Enter the amount of pulp and paper produced
11. View Summary Data < > Summary Data
I Presented in both table and graphical formats in MMTCOLE
12. Export Data Uncertainty

Review information on uncertainty associated with the default data

1.3 METHODOLOGY

This section provides a guide to using the Wastewater module of the SIT to estimate
greenhouse gas emissions from municipal and industrial wastewater treatment. The
methods used in this module are taken from the report by the Intergovernmental Panel on
Climate Change (IPCC) entitled IPCC Guidelines for National Greenhouse Gas Inventories
(IPCC 2006) and are presented as used in the Inventory of U.S. Greenhouse Gas Emissions
and Sinks (U.S. EPA 2021).

There are twelve general steps involved in estimating emissions using the Wastewater
module: (1) select industrial wastewater sources; (2) select a state; (3) select emission
factors and other variables used throughout the module; (4) complete municipal wastewater
worksheet; (5) review direct N2O emissions from municipal wastewater treatment
worksheet; (6) complete municipal wastewater N2O emissions worksheet; (7) complete
industrial wastewater CHa4 - fruits and vegetables worksheet; (8) complete industrial
wastewater CH4 - red meat worksheet; (9) complete industrial wastewater CH4 - poultry
worksheet; (10) complete industrial wastewater CH4 - pulp and paper worksheet; (11)
review summary information; and (12) export data. The Wastewater module will
automatically calculate emissions after you make choices on the control worksheet and
enter the required data on the individual sector worksheets. The tool provides default data
for most sectors.
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Step (1) Select Industrial Wastewater Sources

To begin, select the industrial wastewater sources you would like to analyze in step 1 of the
control worksheet. Check the box to the left of the following industrial wastewater sectors
you would like to analyze: fruits and vegetables, red meat, poultry, and pulp and paper.
Step (2) Select a State

Next, select the state you are interested in evaluating. By selecting a state, the rest of the

tool will automatically reset to reflect the appropriate state default data and assumptions for
use in subsequent steps of the tool. Figure 4 shows an example of the control worksheet.

Figure 4. Example of the Control Worksheet in the Wastewater Module
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Step (3) Select Emission Factors and Other Variables Used Throughout the
Module

The next part of the control worksheet involves selecting default variables or entering state
specific variables in the yellow cells on the control worksheet, as seen in Figure 4. The
required inputs for each sector are discussed further in following steps. Box 2 explains
terminology used throughout the module. Default factors for all parameters are provided in
the control worksheet and may be selected by clicking the gray “Clear / Select All Defaults”
at the top of the worksheet. These factors are drawn from the Inventory of U.S.
Greenhouse Gas Emissions and Sinks (U.S. EPA 2021) and are used to estimate emissions
from industrial wastewater. If the user-specific inputs do not match the default data in the
control worksheet (i.e., the default value is overwritten), the text will appear red.
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Box 2: Wastewater Terminology

In highly organic wastewater streams, e.g., streams from food processing plants or pulp
and paper plants, the available oxygen in the water is rapidly depleted as the organic
matter decomposes. The organic content (sometimes known as “loading”) of these
wastewater streams is expressed in terms of biochemical oxygen demand, or BOD. BOD
represents the amount of oxygen taken up by the organic matter in the wastewater during
decomposition. Alternatively, the chemical oxygen demand (COD) is often used to
characterize industrial wastewater. COD refers to the amount of oxygen consumed during
the oxidation of both organic matter and oxidizable inorganic matter. Under the same
conditions, wastewater with a higher BOD or COD will produce more CH4 than wastewater
with a lower BOD/COD.

CH4 from Municipal Wastewater

In the yellow cells for this sector on the control worksheet, enter total biochemical oxygen
demand (BODs)! produced, the fraction of wastewater BODs anaerobically digested, and the
CHa4 emission factor for municipal wastewater emissions.

Direct N2O from Municipal Wastewater

In the yellow cells for this sector on the control worksheet, enter the factor for non-
consumption nitrogen?, the fraction of your state population not on septic systems, and the
direct wastewater treatment plant emissions per person per year.

N20 from Biosolids

In the yellow cells for this sector on the control worksheet, enter the N2O emission factor for
biosolids (the solid potion of human sewage) and the fraction of nitrogen in protein
(FRACnpR).

Industrial Wastewater: Fruits and Vegetables, Red Meat, Poultry, and Pulp
and Paper

In the yellow cells for these sectors on the control worksheet, enter the wastewater outflow
of the particular industrial facility, the organic content of the wastewater, the fraction of
COD anaerobically degraded, and the CH4 emission factor.

Step (4) Complete Municipal Wastewater Worksheet

Click on the gray navigational arrow in step 4 of the control worksheet to complete sector
worksheets and continue to the CH4 from Municipal Wastewater worksheet. On this
worksheet, the annual state population is entered into the blue cells as seen in Figure 5.
Default data from U.S. Census (2021) is provided, if the “Select Default Data” button is
selected.

1 BOD represents the amount of oxygen that would be required to completely consume the organic
matter contained in the wastewater through aerobic decomposition processes (U.S. EPA 2021). A
standardized measurement of BOD is the “5-day test” denoted as BODs.

2 This factor represents the nitrogen loading occurring from wastewater going directly into the waste

stream from residences (i.e. bathwater, laundry, and use of garbage disposals) as well as industrial
wastewater that is not included in the four industries analyzed in this module.
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Figure 5. Example of the Municipal Wastewater CH4 Emissions Worksheet
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The CH4 emissions from municipal wastewater treatment are calculated by multiplying the
state population by the total annual BODs production in metric tons, by the fraction that is
treated anaerobically, and by the CH4 produced per metric ton of BODs (i.e. the emission
factor); the total is then converted to million metric tons carbon dioxide equivalent
(MMTCO:zE). This calculation is shown in Equation 1.

Equation 1. CH4 Emissions from Municipal Wastewater Treatment

CH4 Emissions (MMTCO:zE) =
State Population x BODs Production (kg/day) x 365 days/year x
0.001 (metric ton/kg) X Fraction Treated Anaerobically x Emission Factor (Gg
CH4/Gg BODs) x 106 (MMT/metric ton) x 25 (GWP)

Click on the gray navigational arrow to estimate direct N2O emissions from municipal
wastewater treatment.

Step (5) Review Direct N2.O Emissions from Municipal Wastewater Treatment
Worksheet

There is no required data for this worksheet because the annual state population was

entered in Step (4). Direct N2O emissions from municipal wastewater treatment are
calculated by multiplying total population served, by the fraction of the population not using
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septic systems, by an N20 emission factor per person per year, and then converting to
MMTCO:E as seen in Equation 2.

Equation 2. Direct N2O Emissions from Municipal Wastewater Treatment

Direct N2O Emissions (MMTCO:E) =
State Population x Fraction of Population not on Septic (%) x
Emission Factor (g N2O/person/year) x 106 (metric ton/g) x
106 (MMT/metric ton) x 298 (GWP)

Click on the gray navigational arrow to estimate direct N2O emissions from biosolids in
municipal wastewater treatment.

Step (6) Complete Municipal Wastewater N2O Emissions Worksheet

Municipal wastewater N2O emissions from biosolids are calculated by multiplying the state
population by the total annual protein consumption, by the nitrogen content of protein and
fraction of nitrogen not consumed, and by an N2O emission factor per metric ton of nitrogen
treated, then subtracting direct emissions as well as the percentage of biosolids used as
fertilizer, and finally converting to MMTCOzE. Direct and biosolids N2O emissions are then
added to produce an estimate of total municipal wastewater treatment N20 emissions. This
calculation is shown below in Equation 3. Data on annual per capita protein consumption
for the United States have been published by the United States EPA in Table 7-34 of the
Inventory of U.S. Greenhouse Gas Emissions and Sinks (U.S. EPA 2021).

Equation 3. N20 Emissions from Biosolids Municipal Wastewater Treatment

N20 Emissions (MMTCO:zE) =
[State Population x Protein Consumption (kg/person/year) x
FRACnrr (kg N/kg protein) x Fraction of Nitrogen not Consumed
0.001 (metric ton/kg) - Direct N Emissions (metric tons)] x
[1 - Percentage of Biosolids used as Fertilizer (%)] x
Emission Factor (kg N2O-N/kg sewage N produced) x
44/28 (kg N20 /kg N) X 10°° (MMT/metric ton) x 298 (GWP) +
Direct N2O Emissions
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Figure 6. Example of the Municipal Wastewater N2O Emissions Worksheet
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Sewage sludge is often applied to agricultural fields as fertilizer. Emissions from this use
should be accounted for under Agricultural Soil Management. The Agriculture module of the
SIT is designed to calculate emissions from sewage sludge applied to land, but to be
consistent, users need to enter the percentage of sewage sludge applied to agricultural soils
in the second column of orange cells in order to not double-count emissions, as shown in
Figure 6. At this time, there is no default data for the percentage of biosolids used as
fertilizer.

Click on the gray navigational arrow to estimate CH4 emissions from the industrial

wastewater sectors selected on the control worksheet.

Step (7) Complete Industrial Wastewater CH4 - Fruits and Vegetables
Worksheet

This worksheet calculates emissions from wastewater used for fruits and vegetables. Please
enter the amount of fruits and vegetables processed in metric tons in the yellow cells, as
shown in Figure 7.
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Figure 7. Example of Industrial Wastewater CHs4 - Fruits and Vegetables
Worksheet
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Emissions from treatment of industrial wastewater from processing fruits and vegetables are
based on annual production in metric tons, multiplied by the volume of wastewater
produced per unit production, the average organic matter content of wastewater from those
processes, the CH4 emission factor, the percent treated anaerobically, and then converted to
MMTCO:2E as shown in Equation 4.

Equation 4. CH4 Emissions from Industrial Wastewater for Fruits and Vegetables

CH4 Emissions (MMTCO:zE) =
Production Processed (Metric Tons) x Wastewater Produced (m3/metric ton) x
1,000 (L/m3) x Organic Matter Content (g COD/L) x
Emission Factor (g CH4/g COD) x Percent Treated Anaerobically (%) x
10712 (MMT/g) x 25 (GWP)
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Step (8)

Complete Industrial Wastewater CH4 - Red Meat Worksheet

This worksheet calculates emissions from wastewater from red meat processing. In the
pink cells, enter the amount of red meat processed in metric tons, as shown in Figure 8.

Figure 8. Example of Industrial Wastewater CHs — Red Meat Worksheet
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Emissions from treatment of industrial wastewater from red meat are based on annual
production in metric tons, multiplied by the volume of wastewater produced per unit
production, the average organic matter content of wastewater from those processes, the
CH4 emission factor, the percent treated anaerobically, and then converted to MMTCO:E as
shown in Equation 5. Default data on red meat production are available from USDA (2021).

Equation 5. CHs Emissions from Industrial Wastewater for Red Meat

CH4 Emissions (MMTCO:zE) =
Production Processed (Metric Tons) x Wastewater Produced (m3/metric ton) x
1,000 (L/m3) x Organic Matter Content (g COD/L) X

10712 (MMT/g) x 25 (GWP)

State Greenhouse Gas Inventory Tool User’s Guide for the Wastewater Module
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Step (9) Complete Industrial Wastewater CH4 - Poultry Worksheet

This worksheet calculates emissions from wastewater used for poultry. The required input
is amount of production processed in metric tons in the purple cells, as shown in Figure 9.

Figure 9. Example of Industrial Wastewater CH4 - Poultry Worksheet
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Equation 6 shows that emissions from treatment of industrial wastewater from poultry are
based on annual production in metric tons, multiplied by the volume of wastewater
produced per unit production, the average organic matter content of wastewater from those
processes, the CH4 emission factor, the percent treated anaerobically, with the total then
converted to MMTCO:E.

Equation 6. CH4 Emissions from Industrial Wastewater for Poultry

CH4 Emissions (MMTCO:E) =
Production Processed (Metric Tons) x Wastewater Produced (m3/metric ton) x
1,000 (L/m3) x Organic Matter Content (g COD/L) x
Emission Factor (g CH4/g COD) x Percent Treated Anaerobically (%) x
1012 (MMT/g) x 25 (GWP)
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Step (10) Complete Industrial Wastewater CH4 - Pulp and Paper Worksheet
This worksheet calculates emissions from wastewater used for pulp and paper. The
required data (in the green cells) is the amount in metric tons of (1) woodpulp and (2)
paper and paperboard processed, as shown in Figure 10.

Figure 10. Example of Industrial Wastewater CH4 - Pulp and Paper Worksheet
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As shown in Equation 7, emissions from treatment of industrial wastewater from pulp and
paper are based on annual woodpulp, paper, and paperboard produced in metric tons,
multiplied by the volume of wastewater produced per unit production, the average organic
matter content of wastewater from those processes, the CH4 emission factor, and the
percent treated anaerobically. The total emissions are then converted to MMTCO:E.

Equation 7. CH4 Emissions from Industrial Wastewater for Pulp and Paper

CH4 Emissions (MMTCO:zE) =
[Production Processed Woodpulp (Metric Tons) + Production Processed Paper &
Paperboard (Metric Tons)] x Wastewater Produced (m3/metric ton) x 1,000
(L/m3) x Organic Matter Content (g BOD/L) x
Emission Factor (g CH4/g BOD) x Percent Treated Anaerobically (%) x
10712 (MMT/g) x 25 (GWP)
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Step (11)

Review Summary Information

The steps above provide estimates of total emissions from wastewater. The information
from the control worksheet and data entry worksheets is collected on the summary
worksheet, which displays results in MMTCO2E. Figure 11 shows the summary worksheet
that sums the emissions from all sectors in the Wastewater module. In addition, the results
are displayed in graphical format at the bottom of the summary worksheet.

Figure 11. Example of the Emissions Summary Worksheet in the Wastewater

Module
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Step (12) Export Data

The final step is to export the summary data. Exporting data allows the estimates from
each module to be combined later by the Synthesis Module to produce a comprehensive

greenhouse gas inventory for the state.

To access the “Export Data” button, return
to the control worksheet and scroll down to
step 12. Click on the “Export Data” button
and a message box will open that reminds
the user to make sure all steps of the
module have been completed. If you make
any changes to the Wastewater module
later, you will then need to re-export the
results.

State Greenhouse Gas Inventory Tool User’s Guide for the Wastewater Module

Note: the resulting export file should not be
modified. The export file contains a summary
worksheet that allows users to view the results, as well as
a separate data worksheet with an unformatted version of
the results. The second worksheet, the data worksheet,
contains the information that is exported to the Synthesis
Tool. Users may not modify that worksheet...
Adding/removing rows, moving data, or making other
modifications jeopardize the ability of the Synthesis
Module to accurately analyze the data.
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Clicking “"OK"” prompts you to save the file. The file is already named, so you only need to
choose a convenient place to save the file. After the file is saved, a message box will
appear indicating that the data was successfully exported.

While completing the modules, you are encouraged to save each completed module; doing
so will enable you to easily make changes without re-running it entirely.

Following data export, the module may be reset and run for an additional state.
Alternatively, you may run the remaining modules of the SIT to obtain a comprehensive
profile of emissions for your state.

1.4 UNCERTAINTY

In the upper right-hand corner of the summary worksheet is a button: “"Review discussion of
uncertainty associated with these results.” By clicking on this button, you are taken to a
worksheet that discusses the uncertainty surrounding the activity data and emission factors,
and how the uncertainty estimates for this source category affect the uncertainty of the
emission estimates for your state.
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